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Disclaimer  
 

Considerable time, effort and expense have gone into the development and documentation of the 
PLPAKTM software. The PLPAKTM software has been thoroughly tested and used. The PLPAKTM 
software should be used by engineers with good understanding of concrete behavior, pre-stressing and 
structural mechanics. The user accepts and understands that no warranty is expressed or implied by the 
developers or the distributors on the accuracy or the reliability of the PLPAKTM software. The user must 
explicitly understand the assumptions of the PLPAKTM software and must independently verify the results 
produced by the PLPAKTM software. 
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Copyright 
 
Copyright © BE4E.com, 2000-2022 
All rights reserved. 
 
The PLPAKTM, PLGenTM, PLViewTM, PLCoreManTM, PLPostTM, PTPAKTM, PLTM, PL.EXETM are 
registered trademarks of BE4E.com. 
 
The computer program PLPAKTM

 and all associated documentation are proprietary and copyrighted 
products. Worldwide rights of ownership rest with BE4E.com. 
Unlicensed use of these programs or reproduction of documentation in any form, without prior written 
authorization from BE4E.com is explicitly prohibited. 
 
No part of this publication may be reproduced or distributed in any form or by any means, or stored in a 
database or retrieval system, without the prior explicit written permission of the BE4E.com. 
 
Further information and copies of this documentation may be obtained from: 
 
 
Technical director:  
Youssef F. Rashed, PhD  
Department of structural engineering,  
Cairo University, Egypt.  
 
e-mail: PLPAK@be4e.com 
web: https://www.PLPAK.com  

 

mailto:PLPAK@be4e.com
https://www.plpak.com/


6 PLPAK V2.00 User Manual - PLPOST 

 

Introduction 
The PLPost component of the PLPak is the one responsible for viewing the structural analysis results 
after the PL Core Man has performed the structural analysis based on Boundary Element Modeling. The 
PL Post can be used to view the analysis results at boundaries and supports. In order to view results in 
internal points, the PL Post will resolve for these internal points. 

The PLPost operation diagram 
The figure below shows the operation diagram for the PLPost module. 

 

 



7 PLPAK V2.00 User Manual - PLPOST 

 

The PLPost philosophy 
The PLPost is a post processing module and result viewer. As explained in PLCoreMan manual, the 
PLCoreMan solves points on supports and boundaries only. The job of the post processor is to calculate 
the straining actions at any required point in the model, solving required points only allows the user to get 
the required results with a high level of accuracy in a short processing time.  The result viewer includes 
capabilities that allow the user to view results in the following forms: 

Graphical forms: 

• Strips for any straining action or generalized displacement in any direction. 

• Global and local contours for any straining action or generalized displacement in any direction. 
The user is allowed to vary the quality of the contour by changing the number of points to be 
solved.  This function enables the user to produce very high quality local contours to study stress 
concentration areas in great detail. 

• Support results which include column, beam, wall and soil support results. 

• Paths which is a strip representation which is completely independent from the problem. 

Tabulated forms: 

The PLPost allows the production of a tabulated form for all of the above results. The produced tables can 
be viewed and edited using text editors or any spreadsheet software. 

Additional tools 

• The PLPost saves a binary file that has all the results, this can opened later on and results are 
viewed without any further solving time. 

• The PLPost allows the user to define load combinations within the PLPost, this does not require 
further solving. 
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Starting the PL Post 
The PLPost could either be run from the PLCoreMan as follows or directly: 

Step#1: Load the model from .LC file on PLCoreMan 

 

 

 

 

 

 

Step#2: Load the PLPost 
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The PLPost menus 

The File menu 

 

File | Import LC  
Brings up a dialog box for selecting .LC file. The user can navigate elsewhere to open another .LC file 
from the default folder. 

File | Open  
Brings up a dialog box for selecting a .LC file. The dialog box will show the location of the last project 
that was open. (The user can navigate elsewhere to open another .LC file.) 

File | Save  
Saves the current state of the open .LC file 

File | Page setup  
Brings up a dialog box in which the user can choose the size of the paper, setup the orientation and setup 
the margins 

File | Print Preview  
Brings up a small window in which the user can preview the .gen file before printing 

File | Print  
Brings up a dialog box in which the user can the choose the printer and print the current .gen file 

File | Settings  
Brings up a dialog box used to define the PlPost solver path. 
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The View menu 

View | Toolbars 
Used to control which toolbars should appear on the screen, the same function can be performed using 
right click on any toolbar. 

 

 

 

 

 

 

View | Windows 
The windows menu provides options of tiling different PLGen windows that are used at the same time. 
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View | View options 
Clicking on View Options allows you to change the drawing sequence of the result elements, Grid 
Spacing, Element Thickness, Opacity and Colors of different elements. 

 

Use this button 
to save settings

Use this button to 
restore default settings

Use this list to 
edit the drawing 

mode

Use these lists to edit 
the grid spacing and 
element thickness

Use these 
buttons to delete 
defined material

Use this scroll 
bar to edit the 
column and 

beam 
transperency

 

View | Fonts 
This option allows you to control the fonts used in the results display. 
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View | Show/Hide Reactions 
The Show/Hide commands can be used to show or hide Loads, No. of divisions of every element, Co-
ordinates of the cursor, grid and axis. 

 

View | Show/Hide Legends 
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The Draw menu 
Items that are available from the Draw Menu are available from the draw toolbar. 

 

Draw | Linear Strip 
This strip allows you to view stress results on a series of points. After clicking on linear strip, draw the 
line which will represent the strip. To see control of results check section RESULTS MANAGER. 

 

 

 

 

 

 

 

 

Draw | Rec. Contour 
This strip allows you to view stress results on a series of points. After clicking on rectangular strip, draw 
the rectangle which will represents the results area. To see control of results check section Results 
Manager. 
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Draw | Quad. Contour 
This strip allows you to view stress results on a series of points. After clicking on quadrilateral strip, draw 
the quadrilateral whose results are under inspection. To see control of results check section Results 
Manager. 

 

 

 

 

 

 

 

 

 

 

Draw | Principal Directions 
This command allows you to view stress resultants maximum and minimum in the whole model. Please 
note that before showing principal directions, Main Contours have to be solved. 
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The Action menu 
All commands in Action Menu are available from the Action Toolbar. 

 

Action | Solve 
After drawing any strip or results area, click on Solve command to Solve all points within the drawn 
areas. 
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Action | Query 
This command is used to show stress resultant one single point, Click on Query then click on the required 
point. The results shown are explained in the next section (Results Manager). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Action | Results Manager 
This command shows the results manager which is used to control the properties of the strips and result 
areas which have been previously drawn. 
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PLPost Results 
The following table shows the results that can be shown by PLPost. 

Quantity Description 
Rx Rotation about the X axis 

Ry Rotation about the Y axis 

Uz Deflection in Z axis direction 

Mxx Bendng moment in X direction 

Mxy Twisting moments about X and Y directions 

Myy Bendng moment in Y direction 

Qx Shear Force in X direction 

Qy Shear Force in Y direction 

Mii Bendng moment in i direction 

Mij Twisting moments about i and j directions 

Mjj Bendng moment in j direction 

Qi Shear Force in i direction 

Qj Shear Force in j direction 

Mmax Maximum principal bending moment 

Mmin Minimum principal bending moment 

Mxxdes Design moment in X direction 

Myydes Design moment in Y direction 

Miides Design moment in i direction 

Mjjdes Design moment in j direction 
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Strips: 
 

Choose whether 
the strip should be 

solved or not

Use this button to 
export the result 

file

Use this button to 
delete the strip

Use this box to 
edit the strip 

name

Use this box to 
define start point 

of strip

Define the angle at which results 
should be shown. You can view 

results on prinicipal axis

Use this box to 
define no. of points 

to be solved

List box 
containing 

names of strips

Use the scroll bar 
to control size of 
graphs produced

Checking this 
box shows the 

result

Use this box to 
define end point 

of strip

Use this list to 
choose which 

straining action 
should be 
displayed

 

Strips: This part of results manager is used to control strip properties including ID, Start and End points, 
No. of points within the strip, type of stress resultant that is required to be displayed at this strip. Export 
command is used to export a tabulated format of the strip results, the produced tables can be used by any 
spreadsheet software. 
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Contours: 
This part of the Results Manager is used to control properties of the contour areas. Main Contour is used 
to display contours all over the model, this is the only contour that can not be deleted. Using this dialogue 
you can control Contour ID, Type of stress component to be displayed, N which is the number of colours 
within the contour, spacing between points to be solved within the contour. Export command is used to 
export a tabulated format of the strip results, the produced tables can be used by any spreadsheet software. 

Checking this box 
allows user to 

define maximum 
value for contours

Use this button to 
export the result 

file

Use this button to 
delete the strip

Use this box to 
edit the contour 

name

Checking this 
box allows user 

to define 
minimum value 

for contours

Define maximum 
value to be shown by 

the contour

Use this box to 
define no. of points 

to be solved
List box 

containing 
names of strips

Used to define 
angle at which 

results should be 
displayed

Checking this 
box shows the 

result

Define minimum 
value to be shown 

by the contour

Use this box to 
define spacing 

between points to 
be solved

Used to define 
straining action 

required o be displayed  
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Column Plot: 
This part of result manager is used to show contour results at supports. This part is used to control the 
number of contour colours and type of stress component to be displayed. Export command is used to 
export a tabulated format of the strip results, the produced tables can be used by any spreadsheet software. 
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Action | Paths Manager 
 

 

Action | Select Case 
This command is used to add, modify or remove load cases and combos that are required to be solved and 
displayed by PLPOST. 

 

 

 

 

Defining load combinations: 
Load combos can be defined from this combo. 

Used to add a load 
case to the combo

Use this list to 
choose name of 

loadcase
Define name of 
loadcase combo

List box 
containing names 

of combos

Used to define the 
angle at which 

results should be 
displayed

Used to define the 
multiplication factor 

for every load

Used to remove a 
load case to the 

combo

Used to remove the 
loadcase and combos

Used to button to 
cancel and close 

the window

Use this button to 
save settings and 
close the window
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Action | Assemblies 

This command is used to show the cell properties. In order to show assembly results, type the cell number 
in the lower left box, then click add. The assembly results can be read at the normal X and Y directions or 
at any direction. The results at principal directions can be shown using the command “use principal”. The 
results can be exported to a file with a format that can be opened using any spreadsheet software. 
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Action | PL controls  
Refer to PLCoreMan manual. 

Action | Beams 
This command is used to display and edit beam results. The produced dialogue is used to show beam 
nodes, directions, and type of stress component that should be displayed on the beam. 
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Getting Help 
The BE4E.com customer support team is always welcoming problems and suggestions of registered 
customers. Just send an e-mail including your questions, or your model together with your questions to: 
PLPAK@be4e.com 

Also check our site news at https://www.PLPAK.com regularly for Problems and Solutions section and 
the Frequently Asked Questions section 

 

mailto:PLPAK@be4e.com
https://www.plpak.com/
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